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  مقدمه
. سلامی گرم به همه ي عزیزان بـازي سـاز و علاقـه منـد بـه ایـن صـنعت لـذت بخـش                   . سلام

ق براي اتمـام کـار و امیـدوار بـراي داشـتن           ف مو !امیدوارم در کارهاتون موفق باشید و امیدوار      
چون همونطور که می دونید این صنعت سختی هاي زیـادي داره ولـی بـا کمـی             . پشتکار کافی 

من خودم این آموزش ها رو خوندم و اجرا کردم پس بهتون ایـن   . علاقه همش ناپدید می شه    
شـته شـده رو چنـد بـار      فقـط هـر کـدي کـه نو    . اطمینان رو می دم که حتما می تونیـد بفهمیـد    

کـدهاي هـر درس نـیم تـا یـک سـاعت زمـان        .  و تمرین کنید تا حفظ بشید دخودتون بنویسی 
چرا می گم حفظ کنید؟ اول بگم که منظـورم از حفـظ کـردن فقـط     . براي حفظ شدن نیاز داره    

یعنی وقتی شما فهمیدي و حفـظ هـم   !! دن نیست بلکه اول فهمیدن و بعد حفظ کردنه  رحفظ ک 
خیلـی راحـت کـدهاي      ) دوره ي متوسـطه و پیـشرفته      (ر قسمت هاي بعدي آمـوزش       هستی د 

حالا در مورد موتور هم یـه حرفـی   . به هر حال این تجربه ي من بود     . پیچیده تر رو می فهمید    
این موتور چرا شناخته شده نیـست؟ واقعـا چـرا؟ خـوب معلومـه چـون چنـد ماهـه رو                      . بزنم

!! البته اونجا بشدت طرفدار داشت    . مل مک او اس بود    ویندوز عرضه شده و قبلا رو سیستم عا       
 به بعد ساخته شده و به همین دلیل از ابتداي سـاختش           2005و تازه اینکه این موتور از سال        

به نظر من که بـا ده هـا موتـور دیگـه کـار کـردم ایـن رو             . با تکنولوژي هاي روز ساخته شده     
 ولـی تـو ایـن    د در صد کد بدی ـ    80ما باید   تو موتور هاي دیگه ش    . بهترین می دونم از هر نظر     

 روروي ساخت بـازي بـه صـورت ویـژوال     ون درصد وقتت80موتور به گفته ي سازندگان باید     
  .ن بودهیهدفشون هم!! دبزاری

خب بقیه ي اطلاعات رو خودتون می تونید از سایت ایـن موتـور قدرتمنـد و دوسـت داشـتنی         
  :پیدا کنید
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  Unityمقدمه اي بر ساخت بازي هاي اول شخص با استفاده از موتور 
ایـن  .  مـی باشـد  FPSول شخص یا این آموزش توضیح دهنده ي چگونگی ساخت بازي هاي ا   

آموزش مقدمه ایست بر پایه هاي مفهوم برنامه نویسی سه بعدي و همچنین نشان دادن ایـن             
  .موضوع که چگونه مثل یک برنامه نویس بازي فکر کنید

   ساعت4 تا 3: زمان براي تکمیل 
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  :فایل هاي مورد نیاز را می توانید از لینک زیر دریافت کنید
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  هدف هاي این آموزش.1

. اول اینکه شما علاقه به بازي هـاي کـامپیوتري داریـد           . ا فرض می کند   این آموزش دو چیز ر    
همچنین فرض می کند که شـما  . حال در زمینه ي بازي کردن، طراحی یا مطالعه در مورد آنها     
سـرانجام  .  کامپیوتري را داریـد    يمقداري تجربه برنامه نویسی یا اسکریپت نویسی برنامه ها        

  !!رگی را داریداینکه شما قصد ساخت بازي هاي بز
  . به شما آموزش می دهدUnityاین آموزش چگونگی ساخت بازي اول شخص را توسط 

  
  پیش نیازها.2

.  داشـته باشـید  ی و مفاهیم اسکریپت نویـسی آن آشـنای  Unityشما باید قبلا با واسط کاربري     
  .اگر ندارید می توانید آموزش هایی در مورد آنها را مطالعه بفرمایید

  :ر مورد نیاز براي بازي سازي هستندابزارهاي زی
  برنامه ي مدل ساز سه بعدي.1
  فتوشاپ.2
  

  .شروع می شود، یعنی باید یک کاري را انجام دهید" –"هر خطی که با : توجه
  
  
  
  
  
  
  
  
  
  
  



  
  
  ه ي جدیدژشروع پرو.3
-Unityاین ایده ي خوبیست که آیکون آن را در دسکتاپ خود داشته باشید.  اجرا کنیدا ر.  
  .روژه ي جدیدي بسازیدپ-
  

  
  

 و StandardAssets.  را مـی بینیـد  Unityهـاي داخلـی    ) Asset( شما محتوا  Projectدر پنل   
Pro Standard Assets .       وقتی که ما محتواي جدیدي را ایجـاد مـی کنـیم، بهتـرین راه ایـن

 :نوان مثال به ع.  با نام مرتبط قرار دهیمپوشه هاییاست که آنها را براساس کارایی شان در 
Rocket-Explosion-Audio  

فایل زیر را دانلود کنید و با اجراي آن تمام اسکریپت ها و گرافیک هـاي اسـتفاده شـده در      -
  .این آموزش را به پروژه تان اضافه کنید

fps_assets.zip 

  
  
  



  
  
  آماده سازي محیط بازي.4

فولـدر در  (پوشـه اد زیـادي    شـما مـی بینیـد کـه تعـد          بعد از اینکه محتواها وارد پروژه شدند،      
  . اضافه شده استProject در پنل )ویندوز

مـــــــــــــــــــــــــــــــسیر mainLevelMeshمحتـــــــــــــــــــــــــــــــواي -  را از 
Objects\mainLevelMesh\mainLevelmeshبه داخل صحنه بکشید و رها کنید .  

 در قـسمت بـالاي آن   Project انتخاب شـده اسـت، از پنـل      mainLevelMeshدرحالی که   -
Settingو در پنجره اي که باز می شود مطمئن شوید که گزینه ي  کنید را انتخاب Meshes 

have Colidersرده ک ـ طوق به سادگی صازینه فعال نباشد، بازیکن شمگاگر این .  فعال است
  .و این شی را براي برخورد با آن تشخیص نمی دهد

  
امـل لایـت   نیازي به اضافه کردن هیچ نوري به صحنه ندارید چون این صحنه قبلا به صورت ک        

ضافه کردن صحنه ي آماده به بازي که قبلا لایت مپ شده است باعث مـی           ابا  . مپ شده است  
پردازي رشود که کارایی محیط و بازي به شدت بالا رود و این مورد براي صـحنه هـاي بـا نـو                     

لازم به ذکر است که لایت مپ به معنـی سـاخته شـدن سـایه هـا در           . پیچیده خیلی مفید است   



 این سایه ها به صورت پیش فرض در شی لایت مپ شده ذخیره می شـوند کـه            محیط است و  
  .در این صورت این سایه ها ریل تایم نیستند

  .خب حال شما آماده اید تا شخصیت خود را به صحنه وارد کنید
  اضافه کردن شخصیت اصلی.5

 Prefab یـک  Unity. حال ما مـی رویـم تـا شخـصیتی بـراي کنتـرل بـازي کـن اضـافه کنـیم                
ــود دارد   ــرل اول شــخص در خ ــراي کنت ــصوص ب ــه در. مخ ــسمتک  در Project Panel  ق

Standard Assets\Prefabیافت می شود  .  
 را پیدا کنیـد  Prefabs را باز کنید و در داخل آن Standard Assets پوشه ياز پنل پروژه -

صـحنه نـشان   حال آن در .  را به صحنه  درگ کنیدFirst Person Controllerو از داخل آن 
  .داده می شود

شما باید شی سیلندري را ببینید که بازیکن را نشان می دهد به علاوه ي سه جهـت کـه نـشان        
دهنــده ي مکــان بــازي کــن در صــحنه اســت و همچنــین شــی زرد رنگــی کــه فــضاي دیــد    

)ViewPort (بازیکن را نشان می دهد. FPS Controller     در بردارنـده ي یـک فـضاي دیـد 
 الان بـه  FPS Controller. فضاي دید زیرمجموعه اي از شی دوربین آن اسـت است که این 

عنوان دوربین پیش فرض بازي شماست و با حرکت آن، دوربینی که صحنه ي بازي را نـشان     
همچنین توجه کنید که یـک آیکـون   . نیز حرکت می کند ) GameViewدر قسمت   (می دهد   

 با بالا بـردن آن، دیـد بـازیکن نیـز بـالاتر از       می باشد کهFPS Controllerدوربین در بالاي 
  .سطح زمین می رود

. ، می توانید آن را پاك کنیـد د در صحنه نداریMainCameraچون شما دیگر نیازي به شی     -
 ایکـه در  MainCamera مربوط به خود صحنه و نـه        MainCameraالبته دقت کنید که شی      

  . استFPS Controllerداخل 
شما خواهید دید که مـی توانیـد بـا کلیـد          .  در بالاي محیط ادیتور بزنید     راPlayحال دکمه ي    -

  . و همچنین ماوس درمحیط بازي گردش کنیدW.S.A.Dهاي 
  .بیایید به بازیکن یک اسلحه بدهیم! حال شما یک بازي اول شخص ساده ساخته اید

  
  
  
  



  
  
  
  اضافه کردن اسلحه.6

رنجـک بـدهیم تـا بتوانـد آن را بـه داخـل             حال ما می خواهیم که به بازیکن یک شی شـبیه نا           
 بنویـسید تـا بـه       براي این منظـور، شـما بایـد مقـداري کـد جاوااسـکریپت             . محیط پرتاب کند  

Unityرفتار اسلحه ي خود را شرح دهید .  
بنابراین ما چه کار می خواهیم بکنیم؟ ما می خواهیم به بازیکن اجازه دهـیم کـه بـه نقطـه اي      

هرچنـد بایـد ابتـدا در مـورد شخـصیت       . کند شی اي را پرتاب کنـد      که دوربین بازي نگاه می      
شخصیت بازي ما از نماي اول شخص نگاه مـی کنـد کـه    . بازي و اسلحه هاي آن توضیح دهیم    

 کـرد، آن  لیکهنگامی که بازیکن با اسـلحه اي ش ـ . دوربین در مکان چشم هاي آن قرار دارد 
 این .ک کند نه از جایی که نگاه می کند     اسلحه باید از جایی که دست شخصیت قرار دارد شلی         

یعنی اینکه ما می خواهیم شی اي بسازیم که به عنوان نارنجک انداز عمل کنـد و آن را جـایی     
این کار باعث می شود که مطمـئن شـویم        . قرار دهیم که شخصیت دستش در آنجا قرار دارد        

  . اسلحه از مکان مناسب شلیک می کند
  

  ساختن نارنجک انداز
 شی بازي آیتمی است که در     . بیایید شی اي به عنوان نارنجک انداز به صحنه اضافه کنیم           ابتدا

و کامپوننت نیز رفتـاري اسـت کـه    ) مثل مدل ها و صدا و غیره(دنیاي سه بعدي قرار می گیرد 
  .بنابراین شما کامپوننت ها را به اشیاء بازي اضافه می کنید. به شی بازي تعلق می گیرد

 را انتخاب کنید و نـام آن  Game Object>Create Emptyگزینه ي از منوي اصلی  -
 دقت کنید که ایـن شـی   . تغییر دهیدLauncher به Hierarchy Viewقسمت را در 

در صحنه نمایان نیست چـون یـک شـی خـالی اسـت و فقـط بـراي نگـه داري مکـان                    
  .نارنجک انداز از آن استفاده خواهیم کرد

 مـا در کجـاي آن قـرار    Launcher تا ببینیم شـی  FPS Controllerحال بیایید برویم سراغ 
  .می گیرد



 را انتخاب کرده و مطمئن شوید کـه نـشانگر مـاوس بـر روي     FPS Controllerشی  -
 FPS Controller را بزنید تا به سمت شی Fکلید .  قرار داردScene Viewقسمت 
  .زوم شود

 Gameی گزینـه ي   را انتخـاب کـرده و سـپس از منـوي اصـل     Launcherحال شـی   -

Object>Move to viewدقــت کنیــد کــه چگونــه شــی .  را بزنیــدLauncher در 
حال ما مـی تـوانیم کنتـرل کنـیم کـه      .   قرار می گیردFPS Controllerنزدیکی شی 

همچنـین شـما    .  چگونه در قسمت تقریبا دست شخصیت قرار گیـرد         Launcherشی  
د کـه شخـصیت شـما چـپ دسـت یـا        تعیین کنی ـLauncherمی توانید با تغییر مکان   

 .راست دست است که نیازي به کد نوشتن نیست

(  اسـت Split 2 در حالـت  Unity محـیط  GUIمطمئن شوید که طرح بندي پنجره ي  -
سـپس  .  را انتخـاب کنیـد  Window>Layouts>2 Splitنـوي اصـلی گزینـه ي    ماز 

 Hierarchy View در قـسمت  Launcherمطمئن شوید که شـی  . بازي را اجرا کنید
نگـاه مـی    ) Scene View( انتخاب شده است و سپس در حالی که بـه نمـاي صـحنه    

 ما با شخـصیت مـا   Launcherمی بینید که شی . کنید، شخصیت بازي را حرکت دهید    
 ). کنیدقفبازي را متو.( حرکت نمی کند

 به داخـل شـی   Hierarchy View را از قسمت Launcherبراي حل این مشکل شی  -
Main Camera در شـی  FPS Controller حـال بـازي را اجـرا کنیـد    . درگ کنیـد  .

 نیز با Launcherه و به نماي صحنه نگاه کنید که چگونه شی          ادشخصیت را حرکت د   
 .حرکت دوربین حرکت می کند

  
  ساختن شی نارنجک

را زد، ) کلیک چپ مـاوس ( حال بیایید شی نارنجک را بسازیم تا وقتی که بازیکن کلید شلیک    
  .را به جلو پرتاب کنیمآن 

 Prefabیـک  .  ی ساده اي مثل یک گوي استفاده مـی کنـیم  شبراي این آموزش ما از    -
)  را انتخـاب کنیـد     Assets>Create>Prefabمنوي اصلی گزینه ي   از  ( جدید ساخته   

  . تغییر دهیدMissileو نام آن را به 
 Game Object>Createاز منــوي اصــلی گزینــه ي .( ازیدس بــيحــال یــک گــو -

Other>Sphereرا انتخاب کنید .( 



 ه Prefab درگ کرده و بر داخـل  Hierarchy Viewرا از قسمت Sphereحال شی  -
Missile در Project Panelدقـت کنیـد کـه آیکـون     .  بیاندازیدPrefab   تغییـر مـی 
 . پاك کنیدHierarchy View را از صحنه یا Sphereحال می توانید شی . کند

  
 Prefabمی خواهید در هنگام اجراي بازي ساخته شود، قانونا بایـد یـک              هر شی اي که     : نکته
  .باشد

  
  نوشتن کد نارنجک انداز

 اي است که از چندین شی بـازي و کامپوننـت تـشکیل شـده     FPS Controller ،Prefabشی 
 مـی  Yاسـت کـه بـر روي محـور     ) Cylinder(  شی سـیلندري  FPS Controllerخود . است
اهیم کد نارنجک انداز خود را به این شی اضـافه کنـیم، در آن حالـت             پس اگر ما بخو   . چرخد

 Man Cameraبنابراین ما کد خـود را بـه شـی    . نمی توانیم به سمت بالا و پایین پرتاب کنیم
  .اضافه می کنیم که می تواند به هر جهت نگاه کند

رفتـار نارنجـک   حال بیایید اولین کد جاوااسکریپت خود را ایجاد کنـیم کـه تعیـین کننـده ي                 
  .انداز است

این کار فایـل  .  را انتخاب کنید   Assets>Create>Javascriptاز منو اصلی گزینه ي       -
 ایـن فایـل   م نـا Project Panelدر قـسمت  .  کندیجاوا اسکریپت خالی اي را ایجاد م

NewBehaviorScriptنام آن را به .  استMissileLauncherتغییر دهید .  
  
براي این کـار از     .  معرفی کنید  Unity دلخواه خود را به       کد  ادیتور مسیرشما می توانید    : نکته

 را انتخـاب کـرده و در پنجـره ي بـاز شـده در                Pereferences>Editمنوي اصلی گزینـه ي      
  .ادیتور خود را وارد کنیدمسیر فایل اجرایی ، External Script Editorقسمت 

  
 Weaponsه و نام آن را بـه   ایجاد کردProject Viewپوشه ي جدیدي در قسمت  -

Script  از این به بعد تمام اسکریپت هاي مربـوط بـه اسـلحه را در ایـن                 .  تغییر دهید
 ه Prefabو همچنــین MissileLauncherحــال اســکریپت . پوشــه قــرار مــی دهــیم

Missileرا به داخل این پوشه درگ کنید .  
  : بیاندازیمMiissileLauncherحال بیایید نگاهی به کد کامل 



  
  
ما ابتدا می خواهیم بفهمـیم بـازیکن چـه زمـانی کلیـد      . چه کار می خواهیم بکنیم؟ خوبه   . خب

شلیک را می زند تا اول یک شی نارنجک را بسازیم و سپس به سمت جایی که دوربـین نگـاه             
خـط هـاي بـالا بـه ترتیـب در زیـر       .  بیایید بیشتر توضیح بدهیم .می کند به آن نیرویی بدهیم     

  :می شوندتوضیح داده 
 بـر  Fire1کلمـه ي  . این خط می فهمد که چه زمانی بازیکن کلید شلیک را زده اسـت       .1

بـراي تغییـر تنظـیم و تنظیمـات دیگـر از      . روي کلیک چپ ماوس تنظیم شـده اسـت    
  . را انتخاب کنیدEdit>Project Setting>Inputمنوي اصلی گزینه ي 

 اسـتفاده مـی کنـیم کـه سـه      Instantiate مـا از تـابع       Unityبراي ساختن شی اي در       .2
مکان شـی اي کـه قـرار اسـت     . 2شی اي که می خواهیم ساخته شود     . 1: پارامتر دارد 
 .میزان چرخشی که می خواهیم داشته باشد. 3ساخته شود 

مـا آن را بـا یـک متغیرعمـومی  پـر کـردیم تـا           . اولین پارامتر این تابع کاملا منطقی است      
 RigidBodyنـوع ایـن شـی از نـوع     . ر آن قـرار دهـیم  بتوانیم در آینده شی دلخـواه را د   

  . زیرا که ما می خواهیم شی مورد نظر داراي رفتار فیزیکی باشد.است
پس آن شی چیـست؟  . ، شی اي است که ما می خواهیم بسازیمprojectileاولین پارامتر،  

ط ما نوع این متغیر را عمومی تعریف کردیم تـا بتـوانیم بـه سـادگی در محـی          . خوب است 
بـا ایـن روش   .  هر شی اي که خواستیم را به عنوان این متغیر تعیین کنیم         Unityکاربري  

  .هر وقت بخواهیم به سادگی می توانیم شی مورد نظر را عوض کنیم
، مکان شی اي اسـت کـه اسـکریپت بـه آن اضـافه         transform.positionدومین پارامتر،   

 شـبیه همـین پـارامتر اسـت بـا ایـن       سومین پارامتر نیز. Launcherی شیعنی . شده است 
  . را برمی گرداندLauncherتفاوت که مقدار چرخش شی 



ما نیاز داریم تـا بـه   براي اینکار . این قسمت شی نارنجک ما را به حرکت در می آورد     .3
در قـسمت  ). ؟Z یـا  X،Y( اما در کدام جهـت؟      . بدهیم) Velocity (سرعتینارنجک  

Scene View بر روي شی FPS Controllerنماد هاي حرکـت ظـاهر   .  کلیک کنید
یکی از آنها قرمز، یکی سبز و دیگري آبی   ). را بزنید  Wبراي اطمینان کلید    ( می شند   
 را مشخص می کند و آبـی هـم         Yسبز محور   .  ا مشخص می کند    Xقرمز محور   . است

 همچنین آبی نقطه اي که بازیکن به آن نگاه می کنـد را  . را مشخص می کند Zمحور 
  . به نارنجک بدهیمZپس ما باید سرعتی در جهت محور . ص می کندمشخ

Velocity   خاصیتی  )propery (  ازInstantiatedProjectile  مـا ایـن رو چطـور بایـد        .  اسـت
 ي APIپس اگـر مـا در    است RigidBody از نوع   InstantiatedProjectile. بفهمیم؟ خوبه 

Unity       نگاه کنیم خواهیم دید که Velocity  از خـواص )Property ( بـه    همچنـین .آن اسـت
 ما نیـاز داریـم   Velocityبراي تعیین مقدار .  دارد نگاه کنید  RigidBodyخواص دیگري که    

اشـیاي سـه بعـدي    . البته این یک مقدار بحث نیاز دارد. تا سرعت را در هر جهت تعیین کنیم     
در فـضاي محلـی     ). World(و جهـانی    ) local(محلـی   : از دو مدل مختصات استفاده می کننـد       

)Local Space (     در فـضاي  .مختصات وابسته به شی اي هـستند کـه روي آن کـار مـی کنیـد 
 براي تمـام اشـیاء    یک جهت یعنی همیشه.مختصات مستقل هستند) World Space(جهانی 
بنـابراین وقتـی مقـدار    .  بایـد در فـضاي جهـانی تعیـین گـردد      RigidBody.velocity .دارند

Velocityتعیین می کنید، شما نیاز دارید تا جهت آن در محور  را Z     در فـضاي محلـی را بـه 
شـما ایـن کـار را بـا اسـتفاده از تـابع            . جهت آن در فضاي جهانی مربوط بـه آن تبـدیل کنیـد            

transform.TransformDirection       که یک پارامتر از نوع Vector3        مـی گیـرد انجـام مـی 
 تعیـین  Unity ه GUIن شده اسـت تـا آن را در محـیط     هم عمومی تعیی Speedمتغیر  . دهید
  .کنید

اگر مـا ایـن   . بین نارنجک و کاربر را غیر فعال می کند  ) Collision(این خط برخورد     .4
. کار را انجام ندهیم ممکن است نارنجک هنگاه ساخته شدن با بازیکن برخـورد کنـد             

  . کنید بررسیIgnoreCollision در قسمت Unity ه APIاین تابع را در 
  

فرامـوش  .  وارد کنیـد MissileLauncherکد بالا را در فایل جـاوا اسـکریپت بـا نـام        -
  . نکنید که آن را ذخیره کنید



 FPS در زیـــر مجموعـــه ي Launcher را بـــه شـــی MissileLauncherفایـــل  -

Controller  شما می توانید بـراي اطمینـان از اضـافه شـدن کـد بـه شـی            .  اضافه کنید
Launcher ــی را ــسمت   ، ش ــرده و در ق ــاب ک ــه  Inspector Viewانتخ ــد ک  ببینی

 .اسکریپت نمایان شده است یا خیر

 در projectileهمانطور کـه مـی بینیـد شـی نـارنجکی کـه مـا قـبلا سـاخته بـودیم بـه متغیـر              
متغیـر  .  انجـام مـی شـود      Unity ه   GUIایـن کـار در محـیط        . اسکریپتمان اضافه نشده اسـت    

projectile     ما از نوع RigideBody        است پس ما ابتدا باید مطمئن شویم که شی نارنجک مـا 
  . استRigideBodyداراي کامپوننت 

 انتخـاب  ProjectViewرا از قـسمت  ) missile(براي این کـار، ابتـدا شـی نارنجـک          -
 را Components>Physics>RigideBodyکـــرده و از منـــوي اصـــلی گزینـــه ي 

را که مـی خـواهیم، بـه شـی نارنجـک             RigidBodyاین کار کامپوننت    . انتخاب کنید 
ما این کار را انجـام دادیـم تـا نـوع شـی مـان بـا نـوع متغیـري کـه در           . اضافه می کند 

  .اسکریپت تعیین کردیم یکی باشند
 را  Launcher، ابتـدا شـی      projectileحال براي وصل کردن شی نارنجک بـا متغیـر            -

 در Inspector View را در قــسمت  Projectileانتخــاب کــرده و حــال متغیــر    
تمام کـاري کـه بایـد انجـام         .  می بینید  MissileLauncherزیرمجموعه ي اسکریپت    

 انتخاب کرده و بـه داخـل   Project View نارنجک را از Prefabدهیم این است که 
 . درگ و رها کنیدprojectileمتغیر 

 حال اگر بازي را اجرا کنید می توانید بـا کلیـک چـپ مـاوس کـره ي کـوچکی را بـه                    -
  . این کار را تکرار کنید. طرف جلو پرتاب کنید

  
  انفجارهاي نارنجک. 7

بـراي ایـن   . حال ما می خواهیم که وقتی که نارنجک با چیزي برخورد کرد ، انفجاري رخ دهد  
پـس بایـد فایـل اسـکریپتی را ایجـاد      . کار ما باید رفتاري را براي شی نارنجک تعریـف کنـیم    

  .کنیم
 از منــوي Assets>Create>JavaScriptخــاب گزینــه ي فایــل اســکریپتی را بــا انت -

فایل اسکریپت ایجاد شـده     .  تغییر دهید  Projectileاصلی ایجاد کرده و نام آن را به         
  . درگ کنیدProject View در قسمت Weopensرا به داخل پوشه ي 



  چه کاري براي ما انجام دهـد؟ مـا مـی خـواهیم    Projectileخب ما می خواهیم که اسکریپت       
که این اسکریپت تشخیص دهد چه زمانی نارنجک با چیزي برخورد کرده و سپس انفجـاري               

  :به کد کامل آن دقت کنید. را در آن نقطه ایجاد کنیم
  

  
  

 قرار گیرید، وقتـی کـه شـی اي کـه            OnCollisionEnterهر کدي که در داخل تابع        .1
  .می شوداسکریپت به آن اضافه شده است با شی دیگري برخورد کند، اجرا 

کار اصلی که ما می خواهیم در این تابع انجام دهیم این اسـت کـه انفجـاري در نقطـه           .2
بنـابراین برخـورد کجـا    . اي که شی با شی دیگري برخورد کـرده اسـت ایجـاد کنـیم      

 دارد کـه در  Collision کلاسـی بـا نـام        OnCollisionEnterصورت می گیرد؟ تابع     
ي کـه برخـورد در آن صـورت مـی گیـرد در      نقطـه ا . بردارنده ي این اطلاعات اسـت    

 . ذخیره می شودContactPointمتغیر 

مـا مـی دانـیم کـه بـراي ایجـاد          . جایی که ما انفجـار خـود را در آن ایجـاد مـی کنـیم                .3
)Instantiate (     2. شی اي کـه بایـد ایجـاد شـود    . 1: هر شی نیاز به سه پارامتر داریم .

 . شی در دنیاس سه بعديمیزان چرخش. 3. مکان شی در دنیاي سهد بعدي

همچنـین مـا مـی    .  بعدا تعیین می کنـیم Particle Systemما این را با شی اي از نوع 
 تعیـین کنـیم پـس نـوع آن را عمـومی      Unity ه  GUIخواهیم مقدار آن را از محـیط        

  .تعیین می کنیم
  .  تعیین کردیم2دومین پارامتر، نقطه ي برخورد است که ما مقدار آن را در خط 

مـا مـی خـواهیم     . مین پارامتر چرخش شی ماست که نیاز به مقداري توضـیح دارد           سو
 ه شی انفجار ما در جهت نورمال سطحی کـه نارنجـک بـا آن برخـورد             Yجهت محور   
این به این معنیست که بـراي اشـیایی ماننـد دیـوار بـه سـمت خـارج و           . می کند باشد  

ه ما می خواهیم انجـام دهـیم،     پس کاري ک  . اشیایی مانند کف زمین به سمت بالا باشد       



بـه نورمـال سـطح شـی اي کـه        ه شـی انفجـار در فـضاي محلـی    Yتغییر مکان محـور    
این نکتـه ضـروري اسـت کـه      . در فضاي جهانی، است  نارنجک با آن برخورد می کند     

  . ه انفجار با جهت نورمال شی برخوردي برابر باشدYچرخش محور 
  

. ی اي برخورد کـرد، از صـحنه حـذف شـود        در نهایت می خواهیم وقتی نارنجک با ش        .4
ــابع    ــتفاده از ت ــا اس ــار را ب ــن ک ــارامتر    ()Destroyای ــک پ ــه ی ــیم ک ــی ده ــام م  انج

gameObject    دارد که gameObject   شی اي است که فایل اسکریپت به آن اضـافه 
  .شده است

  
  . وارد کنید و آن را ذخیره نماییدProjectileکد را در داخل اسکریپت  -
 .اضافه کنید) Missile( را به شی نارنجک Projectileاسکریپت  -

  .حال ما می خواهیم شی انفجاري که در زمان برخورد ایجاد می شود را بسازیم
انفجــار ) Asset(بــراي نگــه داري محتــوي ) Explotionبــا نــام  (Prefabابتــدا یــک  -

 کنیـد  دقـت .  درگ کنید تا بتوانید آن را ببینیدScene Viewآن را به داخل . بسازید
که سیستم ذرات فقط تکرار می شود و براي دیـدن نمـاي نهـایی بایـد بـازي را اجـرا         

  .کنید
ــتاندارد   - ــات اس ــک  Standard Assets (Unity(محتوی ــده ي ی  Prefab در بردارن

 ، Standard Assets>Particlesاز مسیر . انفجار خوب با نوري در اطراف آن است
Prefab ه Explotion را به داخل Hierarchy Viewدرگ کنید . 

 دیدید ، آن را به داخـل  Hierarchy Vew را در Explotion ه Prefabبعد از اینکه  -
Prefab ه خود در Project Viewدرگ کنید . 

  .حال ما می توانیم به شی نارنجک انفجار را اضافه کنیم
حـال شـی انفجـاري کـه      . انتخاب شده است  ) Missile(مطمئن شوید که ش نارنجک       -

 درگ و رهـا  Inspector View در قـسمت  Explotionته اید را به داخل متغیر ساخ
  .کنید

  
  تعیین رفتار انفجار

  .حال ما یک اسکریپت جداگانه براي تعیین رفتار انفجار می سازیم



 بگذاریـد و سـپس آن را   Explotionیک فایل اسکریپت جدید بـسازید و نـام آن را           -
بر روي اسکریپت دوبار کلیک . قرار دهید Project View در Weopensدر فولدر 

  .کنید تا براي ویرایش باز شود
کـدي کـه   .  است()Startنوع رایج دیگري از توابع که در اسکریپت ها استفاده می شود، تابع       

تنهـا کـاري   . در این تابع قرار گیرد فقط یکبار در زمانی که شی ایجاد می شود، اجرا می شـود    
. ام دهیم این است که انفجار را بعد از زمـان خاصـی از بـین ببـریم          که ما فعلا می خواهیم انج     

 استفاده می کنیم که دومـین پـارامتر آن میـزان زمـان را              ()Destroyبراي این کار ما از تابع       
  . تعیین می کند

  

  
  

 عمومی تعریف شده است تا بتوانید مقـدار آن را در محـیط کـاربري    explotionTimeمتغیر  
Unity تغییر دهید به سادگی.  

  .  را حذف کنید()Update وارد کنید و تابع Explotionکد بالا را در فایل اسکریپت  -
بـراي ایـن کـار ابتـدا شـی        .  اضـافه کنیـد    Explotionفایل اسکریپت بـالا را بـه شـی           -

Explotion     ــه ي ــلی گزینـــ ــوي اصـــ ــپس از منـــ ــرده و ســـ ــاب کـــ  را انتخـــ
Components>Scripts>Explotionرا انتخاب کنید . 

حال بعد از پرتاب نارنجک، انفجاري در نقطه ي برخورد نارنجک           . بازي را اجرا کنید    -
 .ایجاد می شود و بعد از زمان تعیین شده از بین می رود

  
  افکت هاي صوتی.8

  .بیایید مقداري افکت صوتی به آن اضافه کنیم. دنیاي بازي ما تاکنون خیلی ساکت بوده است
  



  
  

  . ه انفجار اضافه کنیمPrefabتی به ایتدا بیایید یک کلیپ صو
براي اینکه بتوانیم فایل صوتی بـه شـی انفجـار اضـافه کنـیم، بایـد بـه آن کامپوننـت                      -

Audio Sourceبراي اینکار در حالی که شی انفجـار انتخـاب اسـت، از    .  اضافه کنیم
 . را انتخـاب کنیـد  Components>Audio>Audio Sourceمنوي اصلی گزینـه ي  

  . استAudio Clipاین کامپوننت ) Property(د که یکی از خواص حال می بینی
 بـه  Project View را از قسمت Sounds>RocketLauncherImpactفایل صوتی  -

 درگ Inspector View مربوط به شی انفجار در قـسمت  Audio Clipداخل متغیر 
ده ر  و بیـشتر فرمـت هـاي فـشرده شـن      aiff. می تواند فایل هاي صوتی       Unity .کنید

 .پخش کند

حال می بینید که وقتی نارنجک منفجر می شود صـداي انفجـار بـه       . بازي را اجرا کنید    -
 .گوش می رسد

  
  GUIاضافه کردن . 9

 در بازي ها شـناخته مـی   HUD اضافه کنیم که بیشتر با نام GUIحال بیایید به بازي مان یک    
  .شود



  
  

  اضافه کردن مکان نماي ماوس
 را انتخاب کرده و سـپس از منـوي   Textures>aim فایل Project Viewاز قسمت  -

  . را انتخاب کنیدGame Object>Create Other>GUI Textureاصلی گزینه ي 
 در وسط صـفحه ي بـازي نمایـان شـده اسـت و متغیـر آن نیـز در              aimدقت کنید که تصویر     

  . اضافه شده استInspector Viewقسمت 
 پرتـاب نمـی شـود، بایـد شـی      aimاز وسـط  اگـر شـی نارنجـک    . بازي را اجـرا کنیـد    -

Launcherخود را مقداري جابجا کنید تا له مکان مناسب برود .  
  

  فیزیک. 10
ایـن هـدف بـا    . حال ما اشیایی در محیط خود می خواهیم که به صـورت واقعیـت رفتـار کننـد              

 کـه  حال ما اشیایی به صحنه اضافه خواهیم کرد      . اضافه کردن فیزیک به اشیاء محقق می شود       
بـراي ایـن کـار نیـاز داریـم تـا بعـضی از              . وقتی بـا نارنجـک برخـورد کردنـد پرتـاب شـوند            

  .اصطلاحات را توضیح دهیم
  

Update  



 وارد می کردیم، پس ما می توانستیم کـد خـود       Updateقبلا ما کدهاي خود را در داخل تابع         
) Fire(اربر کلید آتـش    براي مثال فهمیدن اینکه چه زمانی ک      . را در هر فریم یکبار اجرا کنیم      

 اما سرعت فریم همیشه یکسان نیست و بـستگی بـه پیچیـدگی محـیط بـازي       .را فشار می داد   
بنـابراین زمـانی   . این بی قاعدگی سرعت فریم باعث ایجاد فیزیک ناپایداري مـی شـود         . دارد

که شما بخواهید فیزیک شی خود را در صحنه آپدیت کنیـد، بایـد کـدهاي خـود را در داخـل       
 براي به دسـت آوردن زمـان        unity در   deltaTime متغیر   .ارد کنید و ()FixedUpdateبع  تا

  .بین دو فریم متوالی استفاده می شود
  : به شرح زیر استUpdate و FixedUpdateتفاوت هاي عمومی بین تابع 

- Update() :                کدهاي داخل این تابع معمولا براي آپدیت کردن رفتـار اشـیاء و منطـق
 در داخـل ایـن تـابع همیـشه یکـسان       deltaTimeمقدار  . به کار می رود   ه  بازي و غیر  
  .نیست

- FixedUpdate() :   کــدهاي داخــل ایــن تــابع بــراي آپیــدیتRigidBody و رفتــار 
 همیشه مقدار ثابتی را در ایـن تـابع برمـی          deltaTime .فیزیکی اشیاء به کار می رود     

 .گرداند

 Fixed Timestepبا استفاده از خاصیتی به اسم  ()FisexUpdateتابع ) تکرار( مدار بسامد
.  قابل دسترسی استEdit>Project Setting>Timeتعیین می شود که در قسمت 

براي .  این خاصیت در بردارنده ي زمان در ثانیه ها است.همچنین می توان آن را تغییر داد
  .بدست آوردن مقدار فریم بر ثانیه، مقدار معکوس این خاصیت را بگیرید

، مواظـب  )عامل موثر فریم بر ثانیه( هستید Fixed Timestepزمانی که در حال تغییر مقدار 
سرعت فریم بیشتر، فیزیک بهتري را بـه ارمغـان مـی آورد    . باشید که بالانس را رعایت کنید   

مطمئن شوید که بـازي بـا سـرعت مناسـب و فیزیـک بـه                . ولی کارایی بازي پایین تر می رود      
  .ا می شودصورت واقعی اجر

  
فکر کنید که این همان کلمه ي کلیدي .  استYieldآخرین اصطلاحی که باید توضیح دهیم 

  .تابع است) Pause(براي نگه داشتن 



  
  چه کاري می خواهیم بکنیم؟.  خب بیایید به بازي خودمان بازگردیم

  ).اده ایککه این کار را قبلا انجام د(به کاربر اجازه بدهیم تا نارنجکی را شلیک کند  .1
 دیگري برخورد کرد، تصمیم بگیریم که کدام اشیاء rigidbodyاگر شی نارنجک با  .2

 . استrigidbodyاي که در اطراف آن وجود دارد داراي خاصیت 

 اي که در محدوده ي موج انفجار قرار دارد، به عنوان تاثیر rigidbodyبراي هر  .3
 .نارنجک، به آن نیرویی در جهت بالا بدهیم

  : نگاهی بیاندازیمExplotion به کد اصلاح شده ي اسکریپت بیایید
  

  



  
  

 هستند در اطاف شـی   colliderاین خط تصمیم می گیرد که کدام اشیاء اي که داراي             .1
یـک  .  سه پارامتر مـی گیـرد      ()Physics.OverlapSphereتابع  . نارنجک قرار دارند  

کـه در کـره ي تعیـین       هـایی    Colliderو آرایـه اي از      . مکان سه بعدي و یک شـعاع      
  .شده قرار دارند را بازمی گرداند

 Rigidbody هـایی کـه خاصـیت    Colliderبعد از اینکه آرایه بـه دسـت آمـد، تمـام       .2
 .دارند، در جهتی مشخص نیرویی بهشان وارد می شود

در مکـانی کـه نارنجـک    ) Yمحـور  (در جهت بـالا  ) نیروي انفجار (این قسمت نیرویی     .3
اما چون نیروي انفجـار بـا دور     ). transform.position. (ی کند فرود می آید ، وارد م     

شدن از آن نیروي کمتري را وارد مـی کنـد، پـس در هـر فاصـله اي از انفجـار نبایـد          
 هایی که در فاصله ي بیشتري از انفجار قـرار       Rigidbody. نیرویی یکسان وارد شود   

انفجـار دریافـت مـی     هاي نزدیک بـه  Rigidbodyدارند، نیروي کمتري را نسبت به       
بـه دلیـل اینکـه دو متغیـر         . محاسـبه و تعیـین مـی شـود        این تاثیر در این تـابع       . کنند

explotionPower   و explotionRadius    به صورت عمومی تعریف شـده انـد، پـس 
 . میزان قدرت انفجار را تعیین کردUnityبه راحتی می توان در محیط کاربري 

به شی انفجار ما اضافه شده باشد، شـروع بـه   ) Particle System(اگر سیستم ذراتی  .4
 . ثانیه ساتع شدن، دوبازي خاموش می شود0,5و بعد از ) emit(ساتع شدن می کند 

  . را با کدهاي بالا آپدیت کرده و آن را ذخیره کنیدExplotionفایل اسکریپت  -
 Rigidbodyیک مکعب بـسازید و بـه آن         . بیایید اشیایی براي پرتاب کردن بسازیم      -

چندین مکعب دیگر از روي این مکعب کپـی گرفتـه و در محـیط پخـش        . اضافه کنید 
 .کنید

حـال مـی بینیـد کـه     . بازي را اجرا کرده و نارنجک به سمت مکعب هـا پرتـاب کنیـد           -
نارنجـک را دورتـر از مکعـب هـا     . یی به سمت بالا دریافـت مـی کننـد        مکعب ها نیرو  

 .دازه و جهت دریافت نمی کنندبیاندازید تا ببینید که نیرو را به یک ان



 .صحنه ي خود را ذخیره کنید -

  
  خلاصه

حال شما باید . این آموزش نحوه ي ساختن یک بازي اول شخص ساده را به شما آموزش داد              
  .با اصطلاحات زیر آشنا شده باشید

- Asset 
- Camera 
- Light 
- Viewport 
- Prefab 
- Collider 
- Rigidbody 
- Javascript 
- GameObject 
- Update\FixedUpdate 
- Local View\World View 

 
قسمت هاي بعدي این آموزش به شـما نحـوه ي اسـتفاده از تکنیـک هـاي پیـشرفته تـري از           

  .و چندین اصلحه را آموزش خواهد داد) AI(ه هوش مصنوعی ملج
  
  



  
  

  
  


